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Hardware and software requirements Chapter 1.

1. Hardware and software requirements

Hardware requirements
In order to follow this guide you'll need:

 1 eWON with viewON capabilities (for example : eWON 4001, eWON 4101, 
eWON 4005, etc)

 1 PC with access to Internet

Software requirements
eWON configuration software:
The eWON is configured through its embedded web server. So all you need is a 
standard Web Browser software like Internet Exploreri or Firefoxii.

Additionally we suggest you to download the eBuddy utility on our website : 
http://www.ewon.biz (Support/Download Software). 
This utility allows to list all the eWONs on your network and to change the default IP 
address of an eWON to match your LAN IP address range. With eBuddy you can also 
easily backup/restore your configuration or upgrade the firmware of your eWON (if 
required).

viewON  software:
To realize your viewON project you need to install the viewON Editor.

To visualize the on the eWON exported viewON application you need to install the 
viewON Viewer extension. 

Both softwares (Editor and Viewer extension) can be installed using the viewON 
setup. This setup can be downloaded on the eWON web site: http://www.eWON.biz

When you try to open the eWON viewON application on a PC where the Viewer 
extension has not yet been installed, then a popup will show up asking you to confirm 
the download and the installation of the Viewer extension.
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viewON Installation Chapter 2.

2. viewON Installation

Setup Wizard
Download the viewON software from the eWON web site: www.ewon.biz.

Launch the setup.exe file and follow the different steps to install the viewON 
application on your PC.

Choose the language for the installation wizard. This language will also be used for 
the viewON Editor interface.
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2. viewON Installation

Select the components you want to install:

– Editor + viewer: This option will install the viewON Editor application and the 
viewON viewer extension on your PC. The viewer extension is needed on your PC 
to display the viewON application once the project has been exported on your 
eWON.

– Install only the viewer extension: This option will only allow you to display the 
already to the eWON transferred viewON application in your web browser. This 
option will not allow you to create your own application.

viewON 2 (Getting Started) Page 5/39



2. viewON Installation

Click Finish to exit the Setup wizard.

viewON Registration
To register your viewON software open the «Registration Information» window using 
the «Registration» option in the Help menu in the viewON Editor.

Copy or write down the Host Id displayed on this window and click on the 
«Registration site...» link.

You will be redirected to the viewON registration page on the eWON web site .
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2. viewON Installation

Enter on this page following informations:

– viewON S/N: the serial number you received after ordering the viewON software.

– HostID: the Host Id displayed in the viewON software installed on your PC

– eMail: Your email address.

Click on the «Submit» button to confirm your entries.

You will receive a mail containing the created License Key.

Copy this key and enter it into the «Activation Key» field of the «Registration 
Information» window in your viewON editor.
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3. The ViewON Editor Interface

Launch the viewON Editor software:

The viewON editor is divided in several sections:

 Menu bar

 Tool bar

 Project editor

 Working area (Synoptics interface)

 Graph. Properties and resources

 Animations properties

 Actions properties

 Graphical component properties

 Symbol tags editor

The following chapters will contain a brief explication of every section listed here 
above.
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3. The ViewON Editor Interface

Menu bar
Hereunder every menu will be listed with a short description of what can be done 
using each menu.

Project
Use this menu to create, open, rename or save your projects. 

This menu has also to be used to:

– Import the Tags from your eWON (to allow animations and actions based on 
eWON tags)

– Export the project to your eWON 

Synoptics
Use this menu to create, open or save your synoptics.

This menu allows also to print a synoptic or to export the synoptic as bitmap or 
pdf file. 

Edit
Use this menu to edit the selected components on your synoptic.

The menu allows you to:

– copy/past objects

– copy/past dimensions (will only copy the dimensions of the selected object)

– group/ungroup objects

– enter/exit a selected group (allows to work on a separate object of the group 
without need to ungroup)

– lock/unlock objects (lock an object to avoid unintentional move of the object)

– Choose the selection mode (object selection, zone selection, etc)
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3. The ViewON Editor Interface

Drawing
Use this menu to add an object on the synoptic, as for example a rectangle, an 
ellipse,  a path, an image or a text.

The «Insert/Delete a segment» and the «Path operation» options allow you to 
arrange (transform) the object as your pleases.

Using this menu you can also insert:

– special graphical components like a Combo Box or an Alarm History table

– insert a view  (to insert an existing view into the current view; useful for a 
custom menu bar for example)

– insert a symbol (a reusable object) 

With the «Options» sub-menu you can define the behavior of the working area, 
as for example Align on rulers, Forced Line mode, etc.

Transforms
Use this menu to determine the position of the selected object on the synoptic.

This menu allows for example to align the selected objects, to rotate the 
selected object, or to define which object has to be in front or in the back of the 
synoptic. 

Use also this menu to resize the canvas of your synoptic (custom size or fit to 
contents size)

Display
Use this menu to select the frame (opened synoptic) you want to work on. Zoom 
options for the working area are also available.

This menu can also be used to display or hide the grid and the rulers of the 
working area.
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NOTE Most of these options are also accessible on the tool bar of the 
viewON Editor

NOTE Most of these options are also accessible by a right mouse click on 
the selected objects in the working area.

NOTE The – and + buttons of the keyboard can  be used to zoom in or out 
the working area.



3. The ViewON Editor Interface

Utils
This menu allows you to test your application without the need to transfer it first 
on your eWON. The test application window will show up which allows to 
simulate your application.

Help
This menu allows to register the viewON software and to display the information 
about software revision, etc.
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3. The ViewON Editor Interface

Tool bar

Tool Action

The mouse pointer will allow to select a separate object on the synoptic. 
(Selection)
With the mouse you will be able to draw a rectangle to select the objects 
situated in between the rectangle. (Zone selection)
With the mouse you will be able to draw a rectangle to which the working 
area will be zoomed towards. (Zoom on a zone)
Create rectangles and squares.

Create ellipses and circles.

Create a path.  To close the path realize a double click.

Insert an image.

Create a text element.

Insert a graphical component: Button, Check box, Toggle button, Combo 
box, List, Number Editor, Slider, Alarm history, Alarm summary, Menu 
bar, Trends
Insert a view

Insert a symbol

Activate/deactivate the «Repeated actions» mode. Allows for example to 
select by zone or to draw a shape several times, without being reset to 
the regular mode (simple selection mode).
Activate/deactivate the «Keep ratio» mode.

Activate/deactivate the «Align on rulers» mode.

Activate/deactivate the «Close path» mode. If this option is checked, then 
the last point of the drawn path will be automatically linked to the first 
point of the path. 
Activate the «Forced lines» mode. Activate this option if you want to draw 
a line or a square for example (not a curved line).
Test the animations and actions. Will open the application simulator 
window.
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3. The ViewON Editor Interface

Project Editor
The Project Editor allows you to add, rename, import or delete a view to your project.

Use the mouse right click in the Project editor to display the different context menus of 
the Project Editor.

The Project Editor allows you also:

– to define the properties of your project as for example the eWON IP address or 
the display refresh rate.

– to define which view will show up first when the project is opened on the eWON 
(Main view).

Attention: It is important to understand the difference between a View and a Synoptic.

A view is a synoptic which is linked to the project. But not every synoptic is linked to 
the project.

So you can for example open in the working area some synoptics which are not linked 
to the project (not a view) in oder for example to work on a symbol or just to get back 
some objects of an already existing synoptic. Even if these synoptics are displayed in 
the working area, they doesn't make part of the project. If you save the project, these 
synoptics will not be saved. 

To link an existing synoptic to your project, use the «Import view» option. The synoptic 
will then be linked to your project. A copy of the synoptic will be saved into the 
workspace of your project.
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3. The ViewON Editor Interface

Working area

The working area will contain the different views of your project or the synoptics you 
opened.

Click on the different tabs to switch from one synoptic to the other.

To open a view, just click on the view in the Project editor.

To open a synoptic which is not linked to your project (not a view) use the «Synoptics/
Open» menu.

To save the modified Views, just use the «Project/Save project» menu.

To save a synoptic that is not linked to the project (not a view) use the 
«Synoptics/Save» menu or use the close button on the synoptic tab.
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NOTE The keyboard arrow keys can be used to move a selected object. But for 
this, the Synoptic needs to have the focus. To set the focus on the synoptic 
just click with the mouse on the tab of the synoptic, once the synoptic 
displayed. 

The «*» displayed next to the view or synoptic name indicates, that 
modifications have been operated on the synoptic but that these 
modifications have not yet been saved.



3. The ViewON Editor Interface

Graph. Properties and Resources
The Graph. properties section allows to set the properties of the selected graphical 
object. 

If you select for example a rectangle on the synoptic, the Graph. properties section 
will allow you to define following:

– Fill tab:  to define the fill color and opacity
– Line tab: to define the line color, the line 

opacity, the line width and the line dash 
options

– Geom. tab: to define the position and 
dimension of the selected object and to 
define the corner radius

– Id. tab: to define the ID number of the 
object (not of any use in this viewON 
version)

– Display tab: to define the opacity of the 
entire object and if the object should be 
visible or not 

The Graph. resources section allows to define a linear or radial color gradient. This 
color gradient (graph. resource) can then be used to define the fill color of a rectangle 
for example.

– Linear gradient tab: to define a linear 
gradient color

– Radial gradient tab: to define a radial 
gradient color

The icons on the right bottom of the Graph 
resources window allow you to add, duplicate 
or delete a gradient. 

The Gradient properties window can be opened just by a double-click on the gradient 
itself or using the Properties icon on the bottom of the window.
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3. The ViewON Editor Interface

– Colors section: 
Use the «Add a new color item» button to add a 
supplementary color for the gradient definition.

Click on this slider to move the gradient and to 
define the color of the gradient  

– Vector section: Use these fields to define the gradient 
orientation, ex from bottom to top, etc.

– Id section: set the name of the gradient

To apply a linear gradient to the selected 
object (a rectangle for example) use the «Resource» field instead of the color field in 
the Paint section of the Graph. Properties windows:

The gradient color option allows you to give an 3D aspect to your objects as shown on 
the following two objects:

Animations properties
Use the «new» button on the bottom of the animations window to add an animation to 
the selected object.
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3. The ViewON Editor Interface

The context menu will allow you to select the animation you want to apply to your 
object. 

For example, the following picture shows the Animation properties window for a «color 
on state» animation:

The different possible animations are listed in the following table:
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3. The ViewON Editor Interface

Animation  Type Description

Color State Color animation using a state variable (Boolean tag, 
alarm status, alarm type)

Color Measure Color animation using analog tag intervals
Color Bar graph Bar graph animation using analog tag value
Opacity State Opacity animation using a state variable (Boolean 

tag, alarm status, alarm type)
Opacity Interval Opacity animation using analog tag intervals
Opacity Measure Opacity animation using analog tag value
Visibility State Visibility animation using a state variable (Boolean 

tag, alarm status, alarm type)
Visibility Interval Visibility animation using analog tag intervals
Movement Translation Object translation (xy to xy) using analog tag value 
Movement Rotation Object rotation using analog tag value
Movement Scale Object resizing using analog tag value
Text Simple Text animation using eWON Script
Text State Text animation using a state variable (Boolean tag, 

alarm status, alarm type)
Text Measure Text animation using analog tag value. Will display 

the analog tag value.
Text Current User Will display the current logged user

Actions properties

Use the «new» button to add an action to the selected object.

The context menu will allow you to select the actions you want to apply to your object. 
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3. The ViewON Editor Interface

For example the following picture shows the Actions properties window for a «Send 
Command» action:

The different possible actions are listed in the following table:

Action  Type Description

Send Command Send 0 or 1 to a boolean Tag, or execute an eWON 
Script

Send Command by 
reference

Send the boolean value of one eWON Tag into an 
other eWON Tag (for example to create a toggle 
button)

Send Measure Send a value into an analog eWON Tag
Load View Manage views: open a new view, back to previous 

view, close current popup dialog, quit view
Load URL Display an other web page by indicating the URL 
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3. The ViewON Editor Interface

Graphical component properties
There are some special graphical components at your disposal in the viewON Editor 
(Button, List, Alarm history, etc.).

For the graphical components the «Graph. Properties» window does only allow to 
configure the geometrical location and the display options (opacity, visibility, etc).

To define the other properties that are linked to the selected graphical component, the 
«Graphical component properties» window displayed in the bottom of the Editor has 
to be used.

For example, for the graphical component «Button» following window will be 
displayed:

Here you can define the text contents and format of the button .

Or for example, the graphical component  «Alarm summary» can be configured using 
following Graphical component properties window.
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3. The ViewON Editor Interface

Symbol tags editor
You can insert symbols into your view. 

A symbol is an object with predefined graphical components and animations. A 
symbol can be for example a tank or a motor.

Even if the symbol is composed of several different graphical components and 
animations it will be represented in your view as one unique object.

To configure the animations and actions which make part of the symbol, the «symbol 
tags editor» window displayed in the bottom of the viewON Editor has to be used.

If the selected symbol contains animations, then you will find here a list of all the 
different «Symbol Tags» used for the different animations.

Each of the symbol Tag must be linked to an eWON Tag to make the animation of the 
symbol work.

The «<None>» indicates that the symbol tag has not yet been linked to an eWON 
Tag.

To link an eWON Tag select the symbol Tag in the list and click on the browse button 
on the right bottom. 

The «Tag view database» window will show up:
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3. The ViewON Editor Interface

Select the eWON Tag or the Script to link to the symbol 
Tag and click on the OK button.
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4. Animations

To add an animation on an object, select the object in the working area and use the 
«new» button on the bottom of the animations window to select an animation.

The context menu will allow you to select the animation you want to apply to your 
object. 

The following picture shows the Animation properties window for a «color on state» 
animation:

If wanted, configure the Line and Fill check boxes and the associated colors for an 
invalid state. 
viewON will apply the invalid settings (if checked) on the object, when the value 
cannot be read back from the eWON.

The Line and Fill options by default are not of any use in the actual viewON version.

Click on the Tag selection button in the tag field to show up the Tags database.
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4. Animations

This window lists the different tags available on your eWON 
which can be taken into account for the selected animation.
For example, because we choose a «State» animation, only 
boolean tags are listed here.
You can now select the tag to use for the animation. 
You can also use the Script tab to enter an eWON script. 
The result of this script will then be used for the animation.

Animation using a Tag
You can animate your object just by using a Tag value (Boolean or analog)

If you select for example the Tag «O2» in the tags view database window, then the 
animation properties window will look like this:

In the «Tag values» section you must define the colors for the different states of the 
boolean Tag.
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4. Animations

Animation using Tag Attributes
Using the «Attribute filter» option in the «Tag view database» window, it is also 
possible to configure an animation using the alarm states or alarm types of a Tag.

You can then for example animate your objects with a different color for every alarm 
state (None, Alarm, Ack, RTN).

Animation using eWON Script
Instead of using a tag value or a tag status for the animation, you can also animate 
your object using an eWON Script. 
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4. Animations

If for example you want to display the date an time on your viewON synoptic, then 
choose a text object and apply a simple text animation on this object. 
In the «Tag view database» open the Script tab and declare following script:

At every refresh interval, the text object will then be updated with the date and time of 
the eWON.
Other possible scripts could for example be «viewon! = A$» or «viewon! = STR$
(MyTag)», etc.

Multiple animation
It is also possible to combine multiple animations on the same object using the «New» 
button in the Animations properties window.
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NOTE The viewON BASIC scripts will be placed into the «Basic action» stack of 
the eWON. Because the script is used on an animation, the script will be 
placed into the eWON stack at every update interval. 
So develop the viewON Scripts according to this.
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5. Actions

To associate an action to an object, select the object in the working area and use the 
«new» button on the bottom of the Actions window to select an action.

The context menu will allow you to select the actions you want to apply on your object. 

The following picture shows the Actions properties window for a «Send Command» 
action:

Click on the Tag selection button in the «Tag to write» field to show up the Tags 
database.

This window will list the different tags available on your eWON and 
which can be taken into account for the selected action.
For example, because we choose a «Send Command» action, only 
boolean tags are listed here. You can now select the tag to use for 
the animation. 
You can also use the Script tab to enter an eWON script. The 
script will then be executed on the eWON every time the action is 
performed.
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5. Actions

Actions using a Tag
By selecting a Tag, you can force the value of this Tag to 0 or 1.

If you select for example the Tag «bit1», the actions properties window will look like 
this:

In the «Value» field enter the value that will be applied on the selected Tag, every 
time the action is executed.

Actions using eWON Script
Instead of setting directly the value of a tag, you can also run an eWON script every 
time the action is performed.

For example place the following «Send command» action on a button:

This script will set the eWON tag DO1 to 1 every time the action is performed, so 
every time the button is used.
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5. Actions

In the action script you can also use the viewon! variable. Before execution of the 
script on the eWON, the viewon! variable will be replaced by the value set by the 
associated action. For example

In the example shown here above, the DO1 Tag on the eWON will be set to 0 every 
time the action is performed.

Multiple actions

You can also combine multiple actions on the same object using the «New» button in 
the Actions properties window.
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6. Create your viewON project

The following chapters will describe the different steps to realize to create your own 
project on the eWON.

Create a new project

Define the project name and the IP address of your eWON.

In the «User» and «Password» fields enter the eWON adm account or an eWON 
account which has enough FTP access rights.
Following eWON access rights are needed: View IO, Change Configuration, FTP 
server access.

In the «Default viewer user» and the «default viewer password» fields enter the 
eWON account that will be used for the requests to the eWON once the application is 
running on your PC. Leave these fields empty if you want to force the user to log 
himself into the viewON application. 

Following eWON access rights are taken into account by the viewON application:

Access right1 Needed to
View I/O read a value out of the eWON

Force Outputs write a value to the eWON

Acknowledge Alarms acknowledge alarms on the eWON

FTP Server Access access Alarm History and Alarm Summary

eWON File access access Alarm History and Alarm Summary

1 User rights are note taken into account when the action is executed using an eWON script inside the viewON.
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6. Create your viewON project

In the «Refresh rate» field enter the refresh rate in seconds at which the viewON 
Viewer will read the Tags on the eWON for the animations. 
If you attempt to visualize the viewON application over a low connection (GPRS, etc.), 
then don't specify a to low refresh rate.

Import Tags from your eWON
To import the eWON Tags, use the Import tags feature in the Project Menu.

When the FTP transfer window closes without displaying an error message, then the 
tags should have been transferred from the eWON to the viewON project. 
To display the imported tags you'll have to open an action or an animation of an object 
on your synoptic and to display the Tag selection window. 

Add views to the project
In the project editor right click on the project name to show up the context menu.
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6. Create your viewON project

Specify the dimension of the new 
view and enter the name to give to 
the view.

Define the Main view
After adding 3 views (named View1, View2, View3) the project explorer should look 
like this:

To define the view that  will be displayed first at startup of the viewON application, 
right click on the view to open the context menu and select the «Main view» option:

The Main view will be displayed in the Project editor with a red square around his 
icon.
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6. Create your viewON project

Add animations and actions to your objects
In your views add now objects and create the animations and actions you want to 
realize

Test your animations
You can test your project without exporting it to the eWON.

For this, just launch the application simulator using the icon in the tool bar. 

The «animation test» window will then show up:

The upper section of this window shows the result of your project.
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6. Create your viewON project

The lower section of this window allows you to simulate the tag values in order to test 
the configured animations and actions.

Click on the play button to launch the simulator. 

You can then change the value by entering the value in the value field.

You can also use a function to automatically change the values of your tags. For this 
just choose one of the proposed function and define a minimum/maximum value and 
the update period.

Open / Close Views using animation
To open or close a view, the action «Load View» has to be used. Select for example a 
button and add following actions to this button:

The Actions properties window will be displayed:

Click on the target field to define if the new view will replace the actual view or if the 
new view should be displayed as «Popup dialog».
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6. Create your viewON project

Click on the View selection button in the View field to show up the Tags view 
database window:

This window will allow you to choose between following 
actions:
– open an other view
– get back to the previous view
– close the current popup dialog view
– quit the view
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6. Create your viewON project

Export the project to the eWON

To export the project to your eWON, just use the «Export to the device» option under 
the Project menu.
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NOTE The IP address and user account of the eWON for the project export are 
configured in the properties window of the project. To open this window right 
click on the project in the «Project Editor» window and click on the 
Properties option.

IMPORTANT If you changed the connection settings or if you realize the export 
for the first time, then please save the project before exporting the 
project to the eWON.
To save the project use the «Save Project» in the Project menu.
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7. View the project on your eWON

To open the viewON project on your eWON, open following link in your Web browser:

http://eWON_IP_Address/usr/viewon/index.html

(for example http://10.0.0.53/usr/viewon/index.html)

You will first be asked to log into your eWON.

Enter a valid User name and Password for the eWON connection.

If you visualize for the first time the viewON application on your PC and if you didn't 
install the viewON Viewer extension first, then your web browser will inform you that a 
special package is needed to display the application.

Click the OK button, and wait for the download. (~11 MB)

Once the viewON viewer package installed, the viewON application will be displayed 
in your web browser.

If you didn't specify during the project development a default User for the connection, 
then you'll first need to log into the viewON application using following window:
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7. View the project on your eWON

After encoding the login you should see the viewON application in your Browser.

You can also define your viewON project as default home page on your eWON.

To show up the viewON application you'll then just have to enter the IP address of 
your eWON in your web browser.

To set the viewON application as default home page on your eWON, open following 
window on your eWON:

In the «User define home page» field select the «http://your_device_ip/usr/» in the 
combobox and enter following text in the field just behind:  viewon/index.html

Once viewON defined as default home page, you must use following address to 
access back the eWON configuration pages:

http://eWON_IP_Address/index.htm
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NOTE

A yellow warning on your animated object indicates that the tag used 
for the animation couldn't be read from the eWON.

The reason for this can be that the viewer didn't yet finish to read the value 
for the first time, or that the Tag doesn't exist at all on your eWON.

Configuration → System Setup → General → General → Identification 



1. Revisions
Revision Level Date Description

1.0 2008-05-05 First release.
1.1 2008-06-13 Symbol Tag editor added (chapter 3)
1.2 2008-11-17 Access rights added (chapter 6)

i Microsoft, Internet Explorer, Windows and Windows XP are either registered trademarks or trademarks of 
Microsoft Corporation 

ii Firefox is a trademark of the Mozilla Foundation

Document build number:  104

Note concerning the warranty and the rights of ownership:

The information contained in this document is subject to modification without notice. 
The vendor and the authors of this manual are not liable for the errors it may contain, nor for their 
eventual consequences.

No liability or warranty, explicit or implicit, is made concerning quality, the accuracy 
and the  correctness of the information contained in this document. In no case the manufacturer's 
responsibility could be called for direct, indirect, accidental or other damage occurring from any 
defect of the product or errors coming from this document.

The product names are mentioned in this manual for information purposes only. The 
trade marks and the product names or marks contained in this document are the property of their 
respective owners.

This document contains materials protected by the International Copyright Laws. All 
reproduction rights are reserved. No part of this handbook can be reproduced, transmitted or copied 
in any way without written consent from the manufacturer and/or the authors of this handbook

eWON sa, Member of ACT'L Group. Subject to change without notice.
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